Working with an Excel Database

What this lesson covers

You will open an Excel workbook, do a page setup (which includes setting page margins and headers and

footers) and manipulate a spreadsheet database.

Open a workbook

1. Start MicrosorT ExciL 2003.
Pull down the FiLE menu and choose OPEN.

2.
3. In the Oren dialog Look IN box, select the Floppy A drive.
4.

See the file, CHaBoT CoLLEGE DIrECTORY. Click on the
file to select it and then click the Orex button (or
double-click on the file to open it).

5. Look at the Excel 2003 spreadsheet. Note the MENU
bar, the STANDARD toolbar, and the FormaTTING toolbar.
Their uses are similar to the other Office 2003 pro-
grams.

6. You see a sample table that will be explained and
manipulated as a database.

Do Page Setup

Set up the spreadsheet page

1. Pull down the FiLE menu.

2. Choose PAGE SETUP.

3. Click on the Page tab.

4. Choose PortraIT (the tall orientation) for this
lesson. You also have the choice of Lanpscark ( the
wide orientation). If you have data in an Excel file
that is spread over several columns and too wide
for portrait, and you want those columns to print
together on a page, you should use LANDSCAPE
orientation. PORTRAIT is the
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default orientation.
5. Leave the ScALING set to start

| Margins || Headet/Footer || Sheet |

with 100%, and then after you | @rientation

have finished your spreadsheet E,

and adjusted your margins and @ Partrait
column widths, you can use

PaGe BREAKPREVIEW to adjust Scaling

the scaling automatically. This
will be explained in this
exercise.

6. Thisis the place where you set
your paper size. The default is

() Landscape

{(®) adjusk ko ‘:‘f.:- norrnal size
) Fit ta pagels) wide by taII

8.5 by 11 inches.

Paper size: |Letter

7. Click OK.

Print guality: |

Do Page Margins

1. In Page SETUP Oon the FILE menu,

. First page number:
click on the MARGINS tab. =t pad

Prink...

Prink Prewview

Options...

2. On Magrains dialog: Notice on
the screen picture at the right,
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the left and right margins are (e o
set to 0.75 inc% each fnd the ]—IF'age e | Header/Footer | Sheet |

top and bottom margins at 1 Top: Header:
inch each, with the header 1 ~ -D 5 A —
and footer set at 0.5 inches -
from the edge of the page.
3. When you look at the spread- Options...
sheet and see where the page Left: Right:
breaks are, you see that the r = - =
) 075 |- 075 =
columns at the right are not
included on page 1, and so you
should adjust your left and

right margin settings.
4. Set Lerr MarGINat 0.5 inches Bottar: Foater:
and RigHT MARGIN at 0.5 inch. 1 = 0.5 T
5. When setting the top and
bottom margins, you need to
consider your header and [ Herizantally [ verticalty
footer. If you have only one
line in your header and footer, [ ok | [ Cancel
then you could reduce the top
and bottom margins. Set Tor MarGIN at 0.75 inches and Borrom MaraIN at 0.75 inch.
6. Leave the Header position set at 0.50 inch and click HorizoNTALLY in the CENTER ON PAGE section.
7. Click OK.

Cenkter on page

Do Headers/Footers

1. On the Pace Serur dialog, click on the HeaDer/Footer TaB to show the HEADER/FooTER panel.
2. Click on Custom HEADER.
3. In Lert SecTION, CENTER SECTION, and RiGHT SECTION type whatever you want to appear at top left, top center,

To format bext: select the text, then choose the Fonk button,

To insert a page number, date, time, file path, filename, or tab name: position the

insertion point in the edit box, then choose the appropriate button,

To insert picture; press the Insert Picture button, To Format wour picture, place the
cursor in the edit box and press the Faormak Picture button,

@)

Left seckion: Center section: Right section:

and top right of your page.

4. Click OK to approve CustoM HEADER.

5. For Foorter, Click on Custom FOOTER.

6. You will see a Custom Foorter dialog identical to the Custom HeaDER dialog.

7. Note the buttons that are available in both the Cusrom Heaber and Custom Footer dialogs. From left to right,
they provide the following capabilities:
The text button (with the letter A) allows you to format any text you have entered in a header or footer. You
select the text and then click on the text button.
The page number button (with the # sign) inserts at the insertion point a code that will produce a page
number on the printed page.
The number of pages button inserts at the insertion point a code that produces the number of pages. You
may want to print the page number followed by the number of pages, such as Page 1 of 20.
The date button inserts at the insertion point a code that prints the current date.



The time button inserts at the insertion point a code that prints the current time.
The file path button inserts at the insertion point a code that prints the file path.
The filename button inserts at the insertion point a code that prints the name of the file.
The tab name button inserts at the insertion point a code that prints the name of the spreadsheet tab.
The insert picture button inserts at the insertion point a code that prints a picture.
The format picture button is used to format your picture.
& Click OK to approve Heaper/Footer Custom dialog and OK again at the Heaper/Footer dialog.

Do Sheet Setup [ Page " Margins " Header/Footer ] : l

You may have a spreadsheet that _ ,

will print on more than one page. Print area |
If you want your column or row Print Litles

Prink Preview

titles (labels) to print on each Rows to repeat at top: |
page, follow these steps: B
LPCons. ..
Columns bo repeat at left; | .
1. Onthe Pace Serur dialog, click | pyir
on the SHEET tab.

] i)

2. On SHEET DIALOG, there are four [ Gridines [JRow and column headings
sections: PRINT AREA, PRINT TITLES, []Black and white  Comments: | {hone) -
PrINT, and PAGE ORDER. . [] Draft quality Cell errors as: dplayed 3

3. When you select the print area,

. Page order
you must consider whether
you will have rows at top and/ ® Down, then aver g5 EIF 5
- i
or columns at left repeat on © Over, then down EEE
each page. If you want your F

column headings to repeat at
the top of your data columns L
on each page, then you must
omit the row or rows you
want to repeat when you select the print area of the spreadsheet. This is the part of the spreadsheet that
does not include the label row.

4. To select the PRINT AREA, click on the red, white, and blue button at the right of the text box (this minimizes the
window). Then click on the upper left cell of the range you want to include in the print area, hold down the
SuirT key, and then click on the lower right cell of the print range. When the correct print range is shown in
the text box, click on the button at the right of the text box to maximize the window.

5. Under PrinT TITLES, click on the icon at the right of the text box opposite Rows To REPEAT AT TOP to minimize the
window. Then select the label cells you want to repeat. Click on the icon at the right of the text box to maxi-
mize the window.

6. Under PrinT, click GRIDLINES if you want them to print. Click Row AND coLUMN HEADINGS if you want column
letters and row numbers to print. Usually you do not want row and column headings to print.

7. Under PAGE ORDER, you can specify the order in which you want your pages to print if your spreadsheet spans
more than one page in width.

8. When satisfied with Sueer dialog, click OK.

8] 4 I[ Cancel J

Working with an Excel Database

Whatis an Excel Database

An Excel database is a list of persons or entities, addresses, telephone numbers, and/or any information you
want to place in a table format. Each row has the complete information about each person or entity, and each
column represents a category, such as first name, last name, street address, room number, city, state, zip, etc.
Other types of spreadsheet tables could keep track of information such as office supplies, cost, date ordered,
date received, amount on hand, etc.

Guidlines for creating a spreadsheet database

Create one spreadsheet database (or list) per worksheet. Some of the tools used to manipulate information in
lists, such as filtering, can be used on only one list at a time.



A B | C | D | E
1_[Chabot College Directory|
2
3 |Department Fname Lname Title Roo
4 |Academic Services Kaaren Krueg Executive Assistant 212
o |Academic Services Ron Taylor Yice President 214
E |Admissions and Records Judy Young Director 192
7 |AmeriCarps Wanessa Cormier hanager 3300
g |Arts and Humanities Gene (Sroppetti Dean 74
9 |Arfs and Humanities Karen Hashimato Administrative Assistant 112%
10 |Bookstore Kathleen Kaser Manager 3a0r
11 |Bookstore YWayne Makano Aszsistant Manager 3a0r
12 |Business and Information Technology  [Minta Feterson Instruction Technology Coorg 132
13 |Business Services Robert Curry Yice President 223
14 [Business Senices Alice Hsu Accounting Specialist 207
15 [Business Senvices Rosie hogle Program Assistant 2
16 [Business Senices Sreq Fees Business Office Coordinator 207
17 |Business Services Rosalie Waergoetter otaff 140
18 |Career/Transfer Center Lara Bongard Frogram Assistant 145
19 |Children's Center Diana Curl Manager 350¢

The Excel file given you contains a partially completed Chabot College directory. See above a screen picture
of a part of this table. You label the columns with the categories, and each column label must be unique. Use
the first row of the table for column labels. If you need to use more than one word as a label, place the
column label in a single cell and format the cell to word-wrap the label. Excel allows only one row of labels
in a list. Excel uses the labels to locate and categorize data. It’s a good idea to distinguish the labels from the
data by formatting the cells with a border, or using a different format on the labels to set them apart from
the data.

Separate the column labels from a worksheet title, if you have one. Make sure there is at least one blank row
between a title (in this case, “Chabot College Directory”) and the column labels.

Avoid blank rows and columns within the list. There can be individual blank cells in a list. However, there can
be no completely blank rows or columns in a list of data.

Column calculations should be separated from the list. Calculations below your list should be separated
from the list by using at least one blank row between the list and the calculations.

Separate the list from other worksheet data. Include blank columns and blank rows between the list and other
data on the worksheet. Excel uses these blank columns and rows as the “boundary” of the list.

Delete a row

1. Place your cursor in a cell in Row 4.

2. Pull down the Epir menu and choose DELETE.

3. You see a window where you have these choices: SHIFT CELLS LEFT, SHIFT CELLS UP, ENTIRE ROW, Or ENTIRE COLUMN.

4. Click Entire Row and then click the OK button.

5. Click on the Unpo icon on the Stanparp toolbar (or use the keyboard shortcut Ctrl-Z) to restore the row.
Note: If you want the entire row deleted when you choose the Epir > DELETE command, click on the row number
to highlight the entire row first.

Insert a row

1. With your cursor in a cell in Row 5, pull down the INserT menu and choose Rows.

2. Notice that a blank row is inserted just above the row that contained your insertion point.

3. Now undo this command. The blank row disappears.

4. To insert more than one row, highlight the number of rows you want inserted, with the top row of the
selected range just below where you want the multiple rows inserted, and repeat the Step 1 command.



Format Label Row Format | Tools Data  Window ¥

1. Select the cells that contain the column | O Cels... Chrl1 ]
labels. =4

2. Click on the CENTER icon Bow b

3. Click on the FormMAT menu Column 3

4. Click on CELLS S R

5. Click on BoRDERS =

6. Click on OUTLINE, then click OK fukoFaormat, ..

Note: Alternately, you could, after you have
selected the cells you wish to format, right-
click on the selection and select Formar CELLs
from the drop-down context menu (pictured
at far right), or you could click on the little down point-
ing arrow at the right of the BorpErs button on the
ForMATTING toolbar and select - Ay
OUTLINE. IE i
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Format the SpreadsheetTable

Conditional Formatking. ..

Cuk

Copy
Paste

Paste Special. ..

Insert...
Delete, ..

Clear Contents

Insert Cammment

Eormat Cells,..

1. Select the table (excluding the label row which is
already formatted) either by dragging or

_ Draw Borders,.,

Pick From Drop-down List, ..
Create Lisk, ..

Hyperlink. ..

Look Up. ..

as follows: Click in the upper left cell, then :
| Murmber || Alignment ||

Font |

hold down the Suirr key and click in the
lower right cell. Presets

. Click on CeLLs and then on BorDERS, or see

. Click on the ForRMAT menu ‘

Note above for an alternate method.
. Click on desired line style, then click on
vertical line

Mone

Qutine  Inside

. Click on desired line style, then click on -

horizontal line
. Click on OUTLINE.
. Click the OK button.

Size ColumnWidths

Text

Text

Highlight the spreadsheet database table.
Click to drop down the FormMAT menu.
Click on CoLumN

Click on AuroFir SeLectioN. The columns
are widened to accommodate the longest

-

I

T r

| Patterns | Protection

Lire
Skl

Color:

The selecked border style can be applied by clicking the presets, presview
diagram or the buttons abowve,

line in each column.
Note: A quick method for auto adjusting
one column width is to double-click on the
column line.

Sort the Spreadsheet Database

You can sort on Column names or titles. If the columns have no
titles, then the columns are identified by the column letter (col-
umn A, column B, etc.). If there are labels (titles), then the
columns are identified by those names. See the screen picture of
this dialog at the right.

Select the entire spreadsheet.

Click on the Data menu.

Click on Sorr.

Sort on Label (ascending or descending) for primary sort.
Sort on Label (ascending or descending) for a secondary sort.
In the section entitled My LisT Has, select HEADER rRow. This refers
to the column labels, not what we usually think of as a header.

Sk W

[ (] 4 ] [ Cancel
Jeparkment @ #scending
) Descending
Then by
|Lname w | ) Ascending
) Descending
Then by
|Fname w | ) Ascending

My data range has
{®) Header row

) Descending

() Mo header row

[ Qpkions. .. ]

[ Ok, ] [ Cancel




Save the Spreadsheet Database
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Printing a spreadsheet

. Dcpartment Enams Laim: Litls
Before prlntlng’ You Want to make sure | Academic Services Eaaren | Krueq Executive Assistant
that EXCGI Wlll break the pages S0 that the i ."'.cm:!-:rr!i-c Services Ron Taylar ‘v'!-:-: President
. . | Admizsions and Recards Judy foung Diircckar
lnformatlon you want to Stay together | ameriCarps Wanesza | Carmier Manager
. . : . _{Artz and Humanities Gene Groppatti Dizan
will be onone page' You Wlll dO thlS W1th _{Arts and Humanities Karen | Hashimoto Administrative Assistant
the PAGE BREAK PREVIEW feature, _|EBaookstare Kathleen | Kaser Manager
_|Bookstore ‘wagne | Makano Azzizkant Manager
. _|Businesz and Information Technology Minta Pekerson Inztruction Technology Coordinaty
Pa.ge break preVIew _|Business Services Robert | Curry Wice President
Bervices Alice Hsu Accounting Specialist 207
Use the PAGE BREAK PREVIEW feature to see Services Raozic | Magle Praogram &ssistant 221 72363
: : _|Business Services Greg Rees Buzinesz Qffice Coordinater 207 | T23-661
Whether all yqur Columns Wlll p'I'IIlt on _|Business Services Rozsalie | 'wWoergoekber | Staff 40 72367
the page, and if not, make an ad]ustment _|CarcerfTransfer Center Lara Eangard Pragram Assistant 146 I T25-6T2
. h . Th H . 11 _{Children's Center Diana Curl Pelanager F505 S T25-T45
m t 18 ViIeEW. 1s will automatica Y _|Sounzeling Eakrin Hampkan Assersment Fpecialist 1540 ITES-ETE
Change the Scaling. _| Counseling Tram Wa-Kumamotd Counselingfinstructor w0 723151
| Caunseling and Guidance Denise | Maldon Dizan 44 | 125-6T
|DzPE peEEehleen | Allen Caunslen'Coordinator 2405 I T23-65
|Ecez L Baghdl Y Afiming Y | Cabnselor!Coordinator 215 123612
1. Pull down the View menu and choose [Financial aid | KathiinadUinametery | Difkctor 10 |T23-'T1u
PAGE BREAK PREVIEW, _| Grant Development OFfice Kathlecn | Sehdtfer Staff | | T23-681
2 See the VieW Change Wlth the Spread _{Health, P.E. and Athletics Deborah| Marcizso Inztruckar EEIIIEII T23-T20
. s ~  _lInstitutiznal Research Carolyn | Arneld Coordinater 235 | T23-63
sheet Outlined Wlth a SOlid line and a _|Instikutional Research Rajinder | Samra Riescarch Analyst 255 |T23-56
. . . . _|Lanquage Arts Debra | Eling Adminizbrative Azsizkant o2 I T23-630
double hne lndlcatlng Where the page _Library Earbara | Lawrence T echneian Il 115 i T25-6T6)
. _JLibrary Jim Plakthews Coordinator 17 Ta3-61T
will break’. It ShOWS‘ that the laSt | Media Fervices Frank | Franco Etaff 23 723103
column will not print on the same Iredia Services Theve | Piatetshy Diireckor 1304 | 125-675
h fth d h _|President Robert | Carlzon President 2046 T23-66
page asthe reSt ofthe Sprea sneet. _|Puente Famoln | Parada Counzelor!Coordinator 1200 I Ta3-T12
3' Place your Cursor over the dotted line A Zafety and S\".'l:l.lr!tl.l Jack Eizhop Zraff _ . 235 IITES-E\S
. . . . _|=afety and Securiky Zarah Elack Zecurity Comm. Dizpatcher 23048 12563
and drag this line to the solid line at [ scicnce and htath Sarsh | Jahnke Drean zzosl 72363
the ri ht _|Ecience and Math Alice Lo Adminiztrative &ssistant 23] 123-65
g . . _|Eocial Fciences Euzanne | Blackman Etaff TE3 | T23-66
4—. Change the view Ofyour Spreadsheet | =acial Fciences Tency Franco Adminizbrative Azsi A I T23-66T
b k N _Epecial Pragrams Yickoria | Beltran Administrative Az 205 S T23-631
ac tO ORMAL. _|#pecial Programs and Fervices Gerald | Shimada Dizan 203 ITES-ESS
5. If you wish, you can use the PAGe Serup  Limecal Frearane and Sepvicss  Gurald | Shigady  Degy 203 |7a5-608
command on the FiLE menu, and look at the PaGe Sraling

Use the FILE, SAVE As command
Specify the A: drive, name your file, and click on Save.

panel to see that Excel has adjusted the scaling for you _ .
automatically. See the Scaling panel screen picture at ® adustto; (92 [§ [% normal size

the right. _ _ =
. Use the FiLE > PrINT PREVIEW command to make sure O it to: III page(s) wide by tall

6

your spreadsheet will print _

Printer

the way you want.

. Mamme: i gserJet 5I5M PoskScripk b |
Print the Spreadsheet e G
1 PI}J.IH dow}rll the FILE menu. Ty HP LaserJet 5/5M PastScript Find Printer ...
2. Choose the Print command. o 7y
3. Note the bottorq partofthe - . ..

PrinT D1aLoG depicted here. [] Print ta File
4. Under Print range, you can Brint Coni

choose to print all or print vink range opies

certain pages. @ al Mumber of copies: |1 S
5. Under PRINT WHAT you can (O Page(s)  From: | ¥ | To: | 3 |

click on SeLectiON (if you

have selected the portion of  Print what Ijil |j¥| Collate

the data you want to print); (7 selection () Entire workbook

or ACTIVE SHEET(S.), or EN:FIRE @) Active sheet(s)

workBooK. For this exercise,

you will choose Active

SHEET. [ (214 ] [ Close




6. The next setting is to indicate the Numser oF copies. You will leave it at one copy.
7. Click the OK button to print your spreadsheet.

Using the AutoFilter

When you use the AutoFILTER in Excel, you 21 sort...

display only those records in the spreadsheet |

database that meet certain criteria. You can Eieer ’ | | AutoBiker
apply filters to only one list (database) on a Subtotals. .. Show &ll
worksheet at a time. Yalidation. .. fdvanced Filker..,
1. Click any cell in the database table. Text bo Columns...
2. Pull down the Data menu. = - .
3. Point to FiLTer and then click AUTOFILTER. id|| BivotTable and PivotChart Report...
4. To display only the rows that contain a Import External Data *

specific value, click the arrow in the Lisk N

column that contains the data you want ’

to display. See the screen picture of the &ML r

Department list at the right.
5. Click the value. LAl b
6. If you want to apply an additional condition based on a value in Elﬂztlngﬁ.'.l?}

another column, repeat steps 4 and 5 in the other column. The only | pcademic Services

filters available for the other column are the values visible in the Admissions and Records

filtered list. AmeriCarps

7. To turn off AuToFiLTER, pull down the Data menu and click AUTOFILTER. g;fgp;:”ma”ities

See the screen picture of the checked AutoFilter. Click to remove | g iness and Information Technology

the check, which turns off AutoFilter. " Business Services
¥ | AutoFilter CareeriTransfer Center
Children's Center

° ° Sh ||:'|” B
Working with Ranges = Counselg
&dvanced Filker. .. Counseling and Guidance
DsPs
Select a Range of Cells EOPS

Mouse: Position the mouse pointer on the first cell you want to select. | Financial Aid _

Press and hold the mouse button as you drag the mouse pointer from Ere?aTtthD?EE !DEITdEEEh?JEi':;

the first cell in the range to the last cell in the range of cells you want to [y y-ymm—"

select. A better method may be to select the first cell in the range and

then hold down the Suirt key when you click the last cell in the range. Using either method, the cells you select
will be highlighted in black, with a heavy border surrounding the cells. The first cell in the selection will not be

highlighted in black to indicate that it is the active cell of the range—the first cell where data will be entered.

Keyboard: Use the arrow keys on your keyboard to position the active cell indicator (the heavy border around
the cell) on the first cell in the range of cells you want to select. Hold down the Suirt key while you use the arrow
keys to extend the range. The cells you select will be highlighted in black, with a heavy border surrounding the
cells. The first cell in the selection will not be highlighted in black to indicate that it is the active cell of the
range—the first cell where data will be entered.

Select Several Ranges of Cells

Mouse: To select several ranges, you can use the dragging method previously described for selecting a single
range. Select the first range of cells, and then hold down the CtrL key as you select each additional range. Each
individual range will be become highlighted as it is selected.

Keyboard: Select the first range using the keyboard method previously described. Next, press Suirr+F8 once,
which will cause ADD to appear in the status bar; this is a keyboard indicator that you can add another range
to the selection. Then use the arrow keys to move the active cell to the beginning of the next range. Hold down
the Shift key and use the arrow keys to select the next range. Each time you want to highlight another range, you
will have to begin with the Suirr+F8 key combination.




Using Range Names

Range names are names that you give to one or more cell references that describe the cell or range. These
names can be used to move around a large worksheet or workbook, to select only part of a worksheet for
printing, and in formulas.

A descriptive name in the formula makes it easier to understand the formula. For example, the formula
=AVERAGE(2002Sales) is easier to identify than =AVERAGE(B6:F16).

A range name can be no longer than 255 characters. Use a letter or an underscore for the first character in a
range name—the remaining characters can be letters, numbers, periods, and underscores. Range names
cannot contain spaces. Use the underscore or periods to separate words.

Names can contain uppercase and lowercase letters, though Excel does not distinguish between them. Therefore,
you cannot create two names—Expenses and expenses—in a workbook, even if they are for different worksheets
in the workbook.

Range names that are the same as a cell reference, such as F11 or B52, are not allowed. If you must have a
name that is like a cell reference, use an underscore as the first character of the name.

Range names are absolute cell references. An absolute cell reference is useful especially in formulas to
“freeze” the cell references.

Create a Range Name Ad v &

1. Select the cell or cells you want to name. | Mame Box A,

2. Click the Name Box on the left side of the
FormuLA Bar. See a screen picture of the
NaME Box. It contains the name of the
current cell which, in the pictureis Cell | mames in workbaok:
A4.The Name Box is at the left of the bar | | e m—"—
just beneath the Formatting toolbar. =

3. Type the range name, using the guide- Clase
lines above, and then press ENTER.

4. There is no limit to the number of range
names you can create in a workbook.

5. If you want to delete a range name or Delete
modify the cell range identified by a
RANGE NaME, click the INSERT menu to
drop it down and select NaME, then

Define Name

dild

DEFINE. Refers ko
6. See the DerINE NamE dialog, pictured | =sheetli$as2 e
here.

Print a selection using a range name

By default, Excel prints the entire active worksheet. If you routinely need to print only a portion of a worksheet,
use a range name to identify the portion you want to print:

. Click on the little arrow at the right of the Name Box.

. Thelist of range names displays.

. Select the range name you want. The cells in the range will be highlighted.

. Choose the PrINT command on the FILE MENU.

. The Print dialog box is displayed.

. From the PrINT WHAT area of the dialog box, choose SELECTION.

7 To preview the range before you print, choose Preview. To print the range without previewing it, choose OK.

DOt hA W

Note: If you choose the PriNT button on the toolbar, your entire worksheet is printed, not just the range you
have selected . This is because the default setting in the PriNT WHAT area of the Print dialog box is to print your
entire worksheet.



Miscellaneous tips for working with Excel

Types of data in Excel

There are two types of data used in Excel—constant values and formulas. Constant values include text, num-
bers, dates, and time (essentially everything but formulas). Formulas are calculations, the results of which
appear in the cells; the formula that calculates the result appears in the FormuLa Bar.

Keyboard shortcuts to enter current date or time

Following are keyboard shortcuts you can use to enter the current date or time. To enter the current date, press
and hold the Ctre key, and then type a semicolon (CTrL+;). To enter the current Time, press and hold the CtrL
and SHIFT keys simultaneously, and then type a semicolon (CTrRL+SHIFT+;). The current date and time are based
on your computer’s internal clock.

RenamingWorksheets

Providing useful worksheet names is easy. You can change the names of the worksheet tabs as follows: Double-
click the tab you want to rename; the current name will be highlighted. Type the new name, and press ENTER. A
worksheet name can contain no more than 31 characters (a space is counted as a character). Uppercase, lower-
case, and mixed case are permitted in worksheet names. You cannot use a name more than once in a workbook.

Freezing and Unfreezing Row and Column Headings
With large worksheets, scrolling to the right or scrolling down to see Compare Side by Side with. .
additional data causes the headings, or labels, to roll off the screen. It is . B

possible, by using the Freeze PaANEs command on the Winpow menu, to Hide

freeze row and column headings. The headings will always appear on- Urhide. ..

screen, even when you scroll to see additional data. Freezing panes affects
only the screen display, and has no impact on how the worksheet appears |
when printed. Freezing is a permanent part of the worksheet. When you 1 Chabat College Directory.xs
save the file, the headings remain frozen until you unfreeze the panes. | —

Freeze Panes

%

The cell you select—the active cell—is the key to where the freezing takes place. Freezing always takes place
above and to the left of the active cell. Use the following guidelines for freezing panes:

1. Freeze one or more columns. Select the cell in row 1 that is in the column immediately to the right of the
column(s) you want to freeze. For example, to freeze columns A and B, select cell C1.

2. Freeze one or more rows. Select the cell in column A that is in the row
immediately beneath the row(s) you want to freeze. For example, to Compare Side by Side with,..
freeze rows 1-3, select cell A4.

3. Freeze both columns and rows. Select the cell immediately to the right
and beneath where you want the freezing to take place. For example, to Unhide...
freeze column A and rows 1-4, select cell B5. After you have selected the |
appropriate cell, choose Winpow, FReeze PANEs. A darkened border
appears where the panes have been frozen. These borders are for display 1 Chabot College Directory, xls
purposes only and do not appear when you print the worksheet. You » |
may not be able to see the borders if you have used border formatting. =

4. Unfreeze rows or columns. Choose Winpow, UNFREEZE PANES. You do not have to select a particular cell to
unfreeze panes.

Hide

Unfreeze Panes

Split the window to view two parts of a sheet at the same time

At the top of the vertical scroll bar or at the right end of the horizontal scroll bar, point
to the split bar. When the pointer changes to a split pointer, drag the split bar down to
the position you want. See at the right the split bar which is just above the up arrow of
the vertical scroll bar. Notice that when you split a sheet in this way, both areas that are
split contain scroll bars so that you can scroll the sheet in either window.

Restore a split window to a single pane
To restore a window split into two scrollable areas, double-click any part of the split bar that divides the panes.
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